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Circuits and Tunnels

Note

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's
SNCP feature, which may be used in any topological network configuration. Cisco does not recommend
using its SNCP feature in any particular topological network configuration.
This chapter explains Cisco ONS 15310-MA SDH synchronous transport signal (VC high-order path)
and Virtual Tributary (VC low-order path) circuits and VC low-order path and data communications
channel (DCC) tunnels. To provision circuits and tunnels, refer to the Cisco ONS 15310-MA SDH
Procedure Guide.
Chapter topics include:
•

7.1 Overview, page 7-1

•

7.2 Circuit Properties, page 7-2

•

7.3 VC-12 Bandwidth, page 7-8

•

7.4 VC Low-order Path Tunnels and Aggregation Points, page 7-8

•

7.5 DCC Tunnels, page 7-8

•

7.6 Subnetwork Connection Protection Circuits, page 7-9

•

7.7 Virtual Concatenated Circuits, page 7-11

•

7.8 Section and Path Trace, page 7-17

•

7.9 Bridge and Roll, page 7-18

•

7.10 Merged Circuits, page 7-22

•

7.11 Reconfigured Circuits, page 7-23

•

7.12 Server Trails, page 7-23

7.1 Overview
You can create circuits across and within ONS 15310-MA SDH nodes and assign different attributes to
circuits. For example, you can:
•

Create one-way, two-way (bidirectional), or broadcast circuits.

•

Assign user-defined names to circuits.
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•

Assign different circuit sizes.

•

Automatically or manually route circuits.

•

Automatically create multiple circuits with autoranging. VC low-order path tunnels do not use
autoranging.

•

Provide full protection to the circuit path.

•

Provide only protected sources and destinations for circuits.

•

Define a secondary circuit source or destination that allows you to interoperate an ONS 15310-MA
SDH Linear Multiplex Section Protection configuration with third-party equipment Linear
Multiplex Section Protection confiugrations.

•

Set Linear Multiplex Section Protection circuits as revertive or nonrevertive.

For the ONS 15310-MA SDH CE-100T-8, CE-MR-6 (ONS 15310-MA SDH only), or ML-100T-8 cards,
you can provision circuits either before or after the cards are installed if the slots are provisioned. For
the 15310-MA SDH 15310E-CTX-K9 card, you must preprovision the small form-factor pluggables
(SFPs) (called pluggable port modules [PPMs] in CTC) before you can create an optical circuit.
However, circuits do not carry traffic until the cards and SFPs are installed and the ports are In-Service
and Normal (unlocked-enabled); Out-of-Service and Autonomous, Automatic In-Service
(OO-AU,Automatic In Service); or Out-of-Service and Management, Maintenance
(locked-enabled,maintenance).

7.2 Circuit Properties
You can view information about circuits in the ONS 15310-MA SDH Circuits window, which appears in
network, node, and card view. The Circuits window shows the following information:
•

Name—The name of the circuit. The circuit name can be manually assigned or automatically
generated.

•

Type—The circuit types are: VC high-order path (VC high-order path circuit), VC low-order path
(VC low-order path circuit), LOP Tunnel (VC low-order path tunnel), LAP (VC low-order path
aggregation point), HOP-V (VC virtual concatenated [VCAT] circuit), or VC low-order path-V (VC
low-order path VCAT circuit).

•

Size—The circuit size. VC low-order path circuits are VC12 and VC3. ONS 15310-MA SDH VC
high-order path circuits are VC4, VC4-2c, VC4-3c, or VC4-4c, VC4-8c, and VC4-16c. VCAT
circuits are VC-12-nv or VC3-nv, where n is the number of members.

•

Protection—The type of circuit protection.

•

Direction—The circuit direction, either two-way or one-way.

•

Status—The circuit status. See the “7.2.1 Circuit Status” section on page 7-3.

•

Source—The circuit source in the format: node/slot/port “port name”/VC. (Port name appears in
quotes.) Node and slot always appear; port “port name”/VC might appear, depending on the source
card, circuit type, and whether a name is assigned to the port. If the port uses a pluggable port
module (PPM), the port format is PPM-port number, for example, p2-1. If the port is a E1, DS-3, or
E3 port, port type is indicated, for example, pE1. If the circuit size is a concatenated size (3c, 6c,
9c, 12c), VCs used in the circuit are indicated by an ellipsis, for example, S7..9, (VCs 7, 8, and 9)
or S10..12 (VCs 10, 11, and 12).

•

Destination—The circuit destination in the same format as the circuit source.

•

# of Spans—The number of internode links that constitute the circuit. Right-clicking the column
displays a shortcut menu from which you can choose to show or hide circuit span detail.
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•

State—The circuit state. See the “7.2.2 Circuit States” section on page 7-4.

The Filter button allows you to filter the circuits in network, node, or card view based on circuit name,
size, type, direction, and other attributes. In addition, you can export the Circuit window data in HTML,
comma-separated values (CSV), or tab-separated values (TSV) format using the Export command from
the File menu.

7.2.1 Circuit Status
The circuit statuses that appear in the Circuit window Status column are generated by Cisco Transport
Controller (CTC) based on conditions along the circuit path. Table 7-1 shows the statuses that can appear
in the Status column.
Table 7-1

ONS 15310-MA SDH Circuit Status

Status

Definition/Activity

CREATING

CTC is creating a circuit.

DISCOVERED

CTC created a circuit. All components are in place and a complete path
exists from circuit source to destination.

DELETING

CTC is deleting a circuit.

PARTIAL

A CTC-created circuit is missing a cross-connect or network span or a
complete path from source to destination(s) does not exist.
In CTC, circuits are represented using cross-connects and network
spans. If a network span is missing from a circuit, the circuit status is
PARTIAL. However, a PARTIAL status does not necessarily mean a
circuit traffic failure has occurred, because traffic might flow on a
protect path.
Network spans are in one of two states: up or down. On CTC circuit and
network maps, up spans appear as green lines, and down spans appear as
gray lines. If a failure occurs on a network span during a CTC session,
the span remains on the network map but its color changes to gray to
indicate that the span is down. If you restart your CTC session while the
failure is active, the new CTC session cannot discover the span and its
span line does not appear on the network map.
Subsequently, circuits routed on a network span that goes down appear
as DISCOVERED during the current CTC session, but appear as
PARTIAL to users who log in after the span failure.

DISCOVERED_TL1

A TL1-created circuit or a TL1-like CTC-created circuit is complete. A
complete path from source to destinations exists.

PARTIAL_TL1

A TL1-created circuit or a TL1-like CTC-created circuit is missing a
cross-connect or circuit span (network link), and a complete path from
source to destinations does not exist.

CONVERSION_PENDING An existing circuit in a topology upgrade is set to this status. The circuit
returns to the DISCOVERED status when the topology upgrade is
complete. For more information about in-service topology upgrades, see
Chapter 9, “SDH Topologies and Upgrades.”
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Table 7-1

ONS 15310-MA SDH Circuit Status (continued)

Status

Definition/Activity

PENDING_MERGE

Any new circuits created to represent an alternate path in a topology
upgrade are set to this status to indicate that the circuit is temporary.
These circuits can be deleted if a topology upgrade fails. For more
information about in-service topology upgrades, see Chapter 9, “SDH
Topologies and Upgrades.”

DROP_PENDING

A circuit is set to this status when a new circuit drop is being added.

7.2.2 Circuit States
The circuit service state is an aggregate of the cross-connect states within the circuit.
•

If all cross-connects in a circuit are in the unlocked-enabled service state, the circuit service state is
In-Service (unlocked).

•

If all cross-connects in a circuit are in an Out-of-Service (locked) service state, such as
locked-enabled,maintenance; Out-of-Service and Autonomous, Automatic In-Service
(locked-disabled,Automatic In Service); or Out-of-Service and Management, Disabled
(locked-enabled,disabled), the circuit service state is locked.

•

PARTIAL is appended to the locked circuit service state when circuit cross-connect states are mixed
and not all states are unlocked-enabled. The locked-PARTIAL state can occur during automatic or
manual transitions between states. locked-PARTIAL can appear during a manual transition caused
by an abnormal event such as a CTC crash or communication error, or if one of the cross-connects
could not be changed. Refer to the Cisco ONS 15310-MA SDH Troubleshooting Guide for
troubleshooting procedures.

You can assign a state to circuit cross-connects at two points:

Note

•

During circuit creation, you can set the state on the Create Circuit wizard.

•

After circuit creation, you can change a circuit state in the Edit Circuit window or from the
Tools > Circuits > Set Circuit State menu.

After you have created an initial circuit in a CTC session, the subsequent circuit states default to the
circuit state of the initial circuit, regardless of which nodes in the network the circuits traverse or the
node.ckt.state default setting.
During circuit creation, you can apply a service state to the drop ports in a circuit. You cannot transition
a drop port from the unlocked-enabled service state to the locked-enabled,disabled service state; you
must first put the port in the locked-enabled,maintenance state before changing it to the
locked-enabled,disabled state. For more information about port service state transitions, see
Appendix B, “Administrative and Service States.”
Circuits do not use the soak timer, but ports do. The soak period is the amount of time that the port
remains in the locked-disabled,Automatic In Service service state after a signal is continuously received.
When the cross-connects in a circuit are in the locked-disabled,Automatic In Service service state, the
ONS 15310-MA SDH monitor the cross-connects for an error-free signal. It changes the state of the
circuit from locked to unlocked or to locked-PARTIAL as each cross-connect assigned to the circuit path
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is completed. This allows you to provision a circuit using TL1, verify its path continuity, and prepare the
port to go into service when it receives an error-free signal for the time specified in the port soak timer.
Two common examples of state changes you see when provisioning circuits using CTC are:
•

When assigning the Automatic In Service administrative state to cross-connects in VC-12 circuits
and VC low-order path tunnels, the source and destination ports on the VC-12 circuits remain in the
locked-disabled,Automatic In Service service state until an alarm-free signal is received for the
duration of the soak timer. When the soak timer expires and an alarm-free signal is found, the VC-12
source port and destination port service states change to unlocked-enabled and the circuit service
state becomes unlocked.

•

When assigning the Automatic In Service administrative state to cross-connects in VC high-order
path circuits, the circuit source and destination ports transition to the locked-disabled,Automatic In
Service service state. When an alarm-free signal is received, the source and destination ports remain
locked-disabled,Automatic In Service for the duration of the soak timer. After the port soak timer
expires, VC high-order path source and destination ports change to unlocked-enabled and the circuit
service state to unlocked.

To find the remaining port soak time, choose the Maintenance > Automatic In Service Soak tabs in card
view and click the Retrieve button. If the port is in the locked-disabled,Automatic In Service service state
and has a good signal, the Time Until unlocked column shows the soak count down status. If the port is
locked-disabled,Automatic In Service and has a bad signal, the Time Until unlocked column indicates
that the signal is bad. You must click the Retrieve button to obtain the latest time value.

Note

Although the ML-100T-8 card does not use the Telcordia GR-1093-CORE state model, you can also set
a soak timer for ML-100T-8 card ports. The soak period is the amount of time that the ML-100T-8 port
remains in the Down state after an error-free signal is continuously received before changing to the Up
state. To find the remaining port soak time, choose the Maintenance > Ether/POS Port Soak tabs in
ML-100T-8 card view and click the Retrieve button.
For more information about port and cross-connect service states, see Appendix B, “Administrative and
Service States.”

7.2.3 Circuit Protection Types
The Protection column on the Circuit window shows the card (line) and SDH topology (path) protection
used for the entire circuit path. Table 7-2 shows the protection type indicators that you see in this
column.
Table 7-2

Circuit Protection Types

Protection Type

Description

LMSP

The circuit is protected by a LMSP protection group.

N/A

A circuit with connections on the same node is not protected.

Protected

The circuit is protected by diverse SDH topologies, for example, a Linear Multiplex
Section Protection and 1+1.

Unknown

A circuit has a source and destination on different nodes and communication is
down between the nodes. This protection type appears if not all circuit components
are known.

Unprot (black)

A circuit with a source and destination on different nodes is not protected.
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Table 7-2

Circuit Protection Types

Protection Type

Description

Unprot (red)

A circuit created as a fully protected circuit is no longer protected due to a system
change, such as removal of a 1+1 protection group.

SNCP

7.2.4 Circuit Information in the Edit Circuits Window
You can edit a selected circuit using the Edit button on the Circuits window. The tabs that appear depend
on the circuit chosen:
•

General—Displays general circuit information and allows you to edit the circuit name.

•

Monitors—Displays possible monitor sources and allows you to create a monitor circuit.

•

Subnetwork Connection Protection—Allows you to change linear multiplex section protection
selectors. For more information, see the “7.6 Subnetwork Connection Protection Circuits” section
on page 7-9.

•

Subnetwork Connection Protection Switch Counts—Allows you to change linear multiplex section
protection switch protection paths. For more information, see the “7.6 Subnetwork Connection
Protection Circuits” section on page 7-9.

•

State—Allows you to edit cross-connect service states.

•

Merge—Allows you to merge aligned circuits. For more information, see the “7.10 Merged
Circuits” section on page 7-22.

Using the Export command from the File menu, you can export data from the Linear Multiplex Section
Protection Selectors, Linear Multiplex Section Protection Switch Counts, State, and Merge tabs in
HTML, comma-separated values (CSV), or tab-separated values (TSV) format.
The Show Detailed Map checkbox in the Edit Circuit window updates the graphical view of the circuit
to show more detailed routing information, such as:
•

Circuit direction (unidirectional/bidirectional)

•

The nodes, VCs, and VTs through which the circuit passes including slots and port numbers

•

The circuit source and destination points

•

Open Shortest Path First (OSPF) area IDs

•

Link protection (linear multiplex section protection, unprotected, 1+1) and bandwidth (STMN)

Alarms and states can also be viewed on the circuit map, including:
•

Alarm states of nodes on the circuit route

•

Number of alarms on each node, organized by severity

•

Port service states on the circuit route

•

Alarm state/color of most severe alarm on port

•

Loopbacks

•

Path trace states

•

Path selectors states
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By default, the working path on the detailed circuit map is indicated by a green bidirectional arrow, and
the protect path is indicated by a purple bidirectional arrow. Source and destination ports are shown as
circles with an S and D. Port states are indicated by colors, shown in Table 7-3.
Table 7-3

Port State Color Indicators

Port Color

State

Green

unlocked-enabled

Gray

locked-enabled,disab
led

Purple

locked-disabled,Auto
matic In Service

Light blue

locked-enabled,main
tenance

Notations within or next to the squares or selector pentagons on each node indicate switches and other
conditions. For example:
•

F = Force switch

•

M = Manual switch

•

L = Lockout switch

•

Arrow = Facility (outward) or terminal (inward) loopback (Figure 7-1)

Figure 7-1

Terminal Loopback in the Edit Circuits Window

Move the mouse cursor over nodes, ports, and spans to see tooltips with information including the
number of alarms on a node (organized by severity), a port’s service state, and the protection topology.
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Right-click a node, port, or span on the detailed circuit map to initiate certain circuit actions:
•

Right-click a unidirectional circuit destination node to add a drop to the circuit.

•

Right-click a port containing a path-trace-capable card to initiate the path trace.

•

Right-click a linear multiplex section protection span to change the state of the path selectors in the
linear multiplex section protection circuit.

7.3 VC-12 Bandwidth
The 15310E-CTX-K9 in the ONS 15310-MA SDH performs port-to-port time-division multiplexing
(TDM). The VC low-order path matrix for the 15310E-CTX-K9 has 96 logical VC high-order path ports.
All VC-12 multiplexing is achieved through these logical VC high-order path ports. Although the
15310E-CTX-K9 can support up to 2016 VC-12 cross-connects and 1344 bidirectional VC low-order
path circuits, the maximum number of VC12s that can be provisioned for Software Release 9.0 is 2016
VC 12 low-order path cross-connects and 1008 bidirectional VC12 low-order path circuits.
To view VC low-order path matrix resource usage, use the Maintenance > Cross-connect > Resource
Usage subtabs.

7.4 VC Low-order Path Tunnels and Aggregation Points
To maximize VC-12 cross-connect resources, you can tunnel VC-12 circuits through ONS 15310-MA
SDH nodes. VC-12 tunnels do not use VC low-order path matrix capacity at pass-through nodes, thereby
freeing the cross-connect resources for other VC-12 circuits.
VC low-order path aggregation points (VAPs) allow you to provision circuits from multiple VC-12
sources to a single VC high-order path destination. Like circuits, a LAP has a source and a destination.
The source is the VC high-order path grooming end, the node where the VC-12 circuits are aggregated
into a single VC high-order path. The LAP VC high-order path must be an STMn port. VC low-order
path matrix resources are not used on the LAP source node, which is the key advantage of VAPs. The
LAP destination is the node where the VC-12 circuits originate. Circuits can originate on any ONS
15310-MA SDH card or port.

7.5 DCC Tunnels
Each SDH frame provides four DCCs for network element (NE) Operations, Administration,
Maintenance, and Provisioning (OAM&P): one on the SDH Section layer (DCC1) and three on the SDH
Line layer (DCC2, DCC3, DCC4). The ONS 15310-MA SDH use the Section DCC (RS-DCC) or Line
DCC (MS-DCC) for management and provisioning. When multiple DCC channels exist between two
neighboring nodes, the ONS 15310-MA SDH balances traffic over the existing DCC channels using a
load-balancing algorithm. This algorithm chooses a DCC for packet transport by considering packet size
and DCC utilization. You can tunnel third-party SDH equipment across ONS 15310-MA SDH networks
using one of two tunneling methods, a traditional DCC tunnel or an IP-encapsulated tunnel.
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7.5.1 Traditional DCC Tunnels
In traditional DCC tunnels, you can use the three available channels of the MS-DCC and/or the single
channel of the RS-DCC, when not used for ONS 15310-MA SDH DCC terminations, to tunnel
third-party SDH equipment across ONS networks. A DCC tunnel endpoint is defined by slot, port, and
DCC channel. You can connect any of the four available channels to any other available channel. To
create a DCC tunnel, you connect the tunnel endpoints from one ONS 15310-MA SDH optical port to
another.
Table 7-4 shows the DCC tunnels that you can create.
Table 7-4

DCC Tunnels

DCC

SDH Layer

SDH Bytes

STM1, STM4

DCC1

Section

D1 to D3

Yes

DCC2

Line

D4 to D6

Yes

DCC3

Line

D7 to D9

Yes

DCC4

Line

D10 to D12

Yes

When you create DCC tunnels, keep the following guidelines in mind:
•

An optical port used for a DCC termination cannot be used as a DCC tunnel endpoint, and an optical
port that is used as a DCC tunnel endpoint cannot be used as a DCC termination.

•

All DCC tunnel connections are bidirectional.

7.5.2 IP-Encapsulated Tunnels
An IP-encapsulated tunnel puts an RS-DCC in an IP packet at a source node and dynamically routes the
packet to a destination node. To compare traditional DCC tunnels with IP-encapsulated tunnels, a
traditional DCC tunnel is configured as one dedicated path across a network and does not provide a
failure recovery mechanism if the path is down. An IP-encapsulated tunnel is a virtual path, which adds
protection when traffic travels between different networks.
IP-encapsulated tunneling has the potential to flood the DCC network with traffic, which causes CTC
performance to degrade. The data originating from an IP tunnel can be throttled to a user-specified rate,
which is a percentage of the total RS-DCC bandwidth.
Each ONS 15310-MA SDH supports one IP-encapsulated tunnel. You can convert a traditional DCC
tunnel to an IP-encapsulated tunnel or an IP-encapsulated tunnel to a traditional DCC tunnel. Only
tunnels in the Discovered status can be converted.

Caution

Converting from one tunnel type to the other is service-affecting.

7.6 Subnetwork Connection Protection Circuits
From the Subnetwork Connection Protection Selectors subtab in the Edit Circuits window, you can
perform the following:
•

View the Subnetwork Connection Protection(SNCP) circuit’s working and protection paths.
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Note

•

Edit the reversion time.

•

Set the hold-off timer (HOT) for linear multiplex section protection selector switching.

•

Edit the Signal Fail (SF)/Signal Degrade (SD) bit error rate (BER) thresholds.

•

Change path payload defect indication (PDI-P) settings.

On the Subnetwork Connection Protection Selectors tab, the SF Ber Level and SD Ber Level columns
display “N/A” for those nodes that do not support VC low-order path signal BER monitoring.
In the Subnetwork Connection Protection Switch Counts subtab, you can:
•

Perform maintenance switches on the circuit selector.

•

View switch counts for the selectors.

7.6.1 Open-Ended Subnetwork Connection Protection Circuits
If ONS 15310-MA SDH nodes are connected to a third-party network, you can create an open-ended
Subnetwork Connection Protection circuit to route a circuit through the network. To do this, you create
four circuits. One circuit is created on the source network. This circuit has one source and two
destinations, with each destination provisioned to the interface that is connected to the third-party
network. The second and third circuits are created on the third-party network so that the circuit travels
across the network on two diverse paths to the far-end node. At the destination node, the fourth circuit
is created with two sources, one at each node interface connected to the third-party network. A selector
at the destination node chooses between the two signals that arrive at the node, similar to a regular
Subnetwork Connection Protection circuit.

7.6.2 Go-and-Return Subnetwork Connection Protection Routing
The go-and-return Subnetwork Connection Protection routing option allows you to route the
Subnetwork Connection Protection working path on one fiber pair and the protect path on a separate
fiber pair (Figure 7-2). The working path will always be the shortest path. If a fault occurs, neither the
working or protection fibers are affected. This feature only applies to bidirectional Subnetwork
Connection Protection circuits. The go-and-return option appears on the Circuit Attributes page of the
Circuit Creation wizard.
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Figure 7-2

Subnetwork Connection Protection Go-and-Return Routing

Node A

Any network

Any network

Go and Return working connection
Go and Return protecting connection

96953

Node B

7.7 Virtual Concatenated Circuits
Virtual concatenated (VCAT) circuits, also called VCAT groups (VCGs), transport traffic using
noncontiguous TDM time slots, avoiding the bandwidth fragmentation problem that exists with
contiguous concatenated (CCAT) circuits. The ONS 15310-MA SDH cards that support VCAT circuits
are the CE-100T-8, CE-MR-6, and ML-100T-8 cards.
In a VCAT circuit, circuit bandwidth is divided into smaller circuits called VCAT members. The
individual members act as independent TDM circuits. All VCAT members should be the same size and
must originate/terminate at the same end points.
To enable end-to-end connectivity in a VCAT circuit that traverses through a third-party network, you
must create a server trail between the ports. For more details, refer to the "Create Circuits and VC
low-order path Tunnels" chapter in the Cisco ONS 15310-MA SDH Procedure Guide.

7.7.1 VCAT Circuit States
The state of a VCAT circuit is an aggregate of its member circuits. You can view whether a VCAT
member is In Group or Out of Group in the VCAT State column in the Edit Circuits window.
•

If all member circuits are unlocked, the VCAT circuit is unlocked.

•

If all In Group member circuits are locked, the VCAT circuit state is locked.

•

If no member circuits exist or if all are Out of Group, the state of a VCAT circuit is locked.
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•

A VCAT circuit is locked-PARTIAL when In Group member states are mixed and not all member
states are unlocked.

7.7.2 VCAT Member Routing
The automatic and manual routing selection applies to the entire VCAT circuit, that is, all members are
manually or automatically routed. Bidirectional VCAT circuits are symmetric, which means that the
same number of members travel in each direction. With automatic routing, you can specify the
constraints for individual members; with manual routing, you can select different spans for different
members.
Two types of automatic and manual routing are available for VCAT members on CE-100T-8, CE-MR-6,
and ML-100T-8 cards: common fiber routing and split fiber routing. In common fiber routing, all VCAT
members travel on the same fibers, which eliminates delay between members. Three protection options
are available for common fiber routing: Fully Protected, PCA, and Unprotected. Split fiber routing
allows the individual members to be routed on different fibers or each member to have different routing
constraints. This mode offers the greatest bandwidth efficiency and also the possibility of differential
delay, which is handled by the buffers on the terminating cards or ports. Three protection options are
available for split fiber routing: Fully Protected, Unprotected, and DRI. In both common fiber and split
fiber routing, each member can use a different protection scheme; however, for common fiber routing,
CTC checks the combination to make sure that a valid route exists. If it does not, the user must modify
the protection type.
In both common fiber and split fiber routing, intermediate nodes treat the VCAT members as normal
circuits that are independently routed and protected by the SDH network. At the terminating nodes, these
member circuits are multiplexed into a contiguous stream of data. Figure 7-3 shows an example of
common fiber routing.
VCAT Common Fiber Routing

VCAT
Function

Member 1
VCG-1
Member 2

VC3

VC3

STS-2

STS-2

Member 1
VCG-1
Member 2

VCAT
Function

Intermediate
NE

CE-100T-8
VCAT
Function

Member 1
VCG-2
Member 2

CE-100T-8

STS-3

STS-3

STS-4

STS-4

Member 1
VCG-2
Member 2

VCAT
Function

271783

Figure 7-3
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Figure 7-4 shows an example of split fiber routing.
VCAT Split Fiber Routing

Virtually
Concatenated
Group

VCAT
Function

Traffic

Source VCAT at NE

Table 7-5

Intermediate
NE

Member #1

Intermediate
NE

Member #2

Intermediate
NE

Member #3

VCAT
Function
with
Differential
Delay Buffer

Destination VCAT at NE

Switch Times

Type of circuit

For CE100T-8 card

For CE-MR-6 card

CCAT

60 ms

60 ms

60 ms

90 ms

90 ms

148 ms

LO VCAT

202 ms

202 ms

LO LCAS

202 m

256 ms

SWLCAS

—

500 ms

HO VCAT
HO LCAS

Traffic

124065

Figure 7-4

1

1. The calculated number for HO LCAS includes all the inherent delays of the protocol. Also the CE-100-T
numbers are for a group size of only three members.

Note

The switch time values shown in Table 7-5 does not include differential delay. The maximum
differential delay for CE100T-8 is 48ms. This differential delay is added to the switch time to
get the maximum time.

7.7.3 Link Capacity Adjustment
The CE-100T-8, CE-MR-6, and ML-100T-8 cards support the Link Capacity Adjustment Scheme
(LCAS), which is a signaling protocol that allows dynamic bandwidth adjustment of VCAT circuits.
When a member fails, LCAS temporarily removes the failed member from the VCAT circuit for the
duration of the failure, leaving the remaining members to carry the traffic. When the failure clears, the
member circuit is automatically added back into the VCAT circuit. You can select LCAS during VCAT
circuit creation.
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Note

Although LCAS operations are errorless, an SDH error can affect one or more VCAT members. If this
occurs, the VCAT Group Degraded (VCG-DEG) alarm is raised. For information about clearing this
alarm, refer to the “Alarm Troubleshooting” chapter in the Cisco ONS 15310-MA SDH Troubleshooting
Guide.
SW-LCAS is a limited form of LCAS that allows the VCAT circuit to adapt to member failures and keep
traffic flowing at a reduced bandwidth. SW-LCAS is necessary when interoperating with the ONS 15454
ML-Series cards. SW-LCAS uses legacy SDH failure indicators like path alarm indication signal
(AIS-P) and path remote defect indication (RDI-P) to detect member failure. You can select SW-LCAS
during VCAT circuit creation.
In addition, you can create non-LCAS VCAT circuits, which do not use LCAS or SW-LCAS. While
LCAS and SW-LCAS member cross-connects can be in different service states, all In Group non-LCAS
members must have cross-connects in the same service state. A non-LCAS circuit can mix Out of Group
and In Group members if the In Group members are in the same service state. Non-LCAS members do
not support the locked-enabled,outOfGroup service state; to put a non-LCAS member in the Out of
Group VCAT state, use locked-enabled,disabled.

Note

Protection switching for LCAS and non-LCAS VCAT circuits might exceed 60 ms. Traffic loss for VC
low-order path VCAT circuits is approximately two times more than traffic loss for a VC high-order path
VCAT circuit. You can minimize traffic loss by reducing path differential delay.

7.7.4 VCAT Circuit Size
Table 7-6 lists supported VCAT circuit rates and the number of members for each card.
Table 7-6

ONS 15310-MA SDH Card VCAT Circuit Rates and Members

Card
CE-100T-8
ML-100T-8
CE-MR-6

1

1

Circuit Rate

Number of Members

VC12

1–63

VC3

1-3

VC3

1–2

VC12

1-63

VC3

1-21

VC4

1-7

1. A VCAT circuit with an ONS 15310-MA SDH CE-100T-8 or ML-100T-8 card as a source
or destination and an ONS 15454 ML-Series card as a source or destination can have only
two members.

Use the Members tab in the Edit Circuit window to add or delete members from a VCAT circuit. The
capability to add or delete members depends on whether the VCAT circuit is LCAS, SW-LCAS, or
non-LCAS:
•

For VCAT LCAS circuits, you can add or delete members without affecting service. Before deleting
a member, Cisco recommends that you put the member in the locked-enabled,outOfGroup service
state.
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•

For SW-LCAS circuits used when interoperating with ONS 15454 ML-Series cards, you cannot add
or delete members.

•

For non-LCAS VCAT circuits that use CE-100T-8 or CE-MR-6 cards, adding and deleting members
to/from the circuit is possible, but service-affecting. For ML-100T-8 cards, you cannot add or delete
members from non-LCAS VCAT circuits without affecting the entire VCAT circuit.

Table 7-7 summarizes the VCAT capabilities for the CE-100T-8 and ML-100T-8 cards.
Table 7-7

ONS 15310-MA SDH VCAT Card Capabilities

Card

Mode

Add a
Member

CE-100T-8

LCAS

Yes

SW-LCAS

No

ML-100T-8

CE-MR-6

Delete a
Member

Support
locked-enabled,o
utOfGroup

Yes

Yes

No
1

No
1

Non-LCAS

Yes

LCAS

Yes

Yes

Yes

SW-LCAS

No

No

No

Non-LCAS

No

No

No

LCAS

Yes

Yes

Yes

SW-LCAS

Yes

Yes

No

Non-LCAS

Yes

Yes

No

Yes

No

1. For CE-100T-8 cards, you can add or delete members after creating a VCAT circuit with no protection. During
the time it takes to add or delete members (from seconds to minutes), the entire VCAT circuit will be unable
to carry traffic.

7.7.5 Open-Ended VCAT
For applications where the complete end-to-end VCAT circuit is not in a CTC managed network, CTC
will only see either the source or the destination of the Virtual Concatenated Group (VCG) and some of
the intermediate nodes. Figure 7-5 shows an end-to-end VCAT circuit. The termination points of the
end-to-end VCAT circuit, with VCAT functionality, are referred to as the VCAT-Source and
VCAT-Destination. The termination points of the CTC managed circuit, which is the Open-Ended VCAT
circuit, is referred to as simply the Source and Destination.
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Figure 7-5

Open-Ended VCAT

Destination

SONET/SDH Port

VCAT-Source
Source

VCAT-Destination
Destination

SONET/SDH Port
Non-CTC Managed
Network

240645

CTC Managed
Network

Open-ended VCAT Circuit
End-to-end VCAT Circuit

Open-ended VCAT circuits can originate or terminate on any pair of OC-N ports and you can route
open-ended VCAT circuits using any of the cards and ports supported by VCAT. The CTC circuit
creation wizard provides an additional check box in the VCAT attributes pane to enable Open-VCAT
circuit creation. Enabling the check box differentiates open-ended VCAT from regular VCAT Circuits.
The routing preferences for an open-ended VCAT circuit must be specified in the initial stages of circuit
provisioning. For example, if the circuit is independent fiber routing, then multiple OC-N ports can be
involved. Alternatively, the source of an open-VCAT circuit should always be a card capable of
participating in a VCG. This allows CTC to determine which routing preferences are permissible.

7.7.5.1 Open-Ended VCAT Protection
Table 7-8 summarizes the protection options for open-ended VCAT circuits. Note that members can
have different routing preferences.
Table 7-8

Protection options for Open-Ended VCAT Circuits

Routing Preferences

Routing Mode

Common fiber

Manual/Auto

Protection Options
•

Fully protected (Line only)

•

Unprotected

•

PCA
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Table 7-8

Protection options for Open-Ended VCAT Circuits

Routing Preferences

Routing Mode

Split fiber

Manual/Auto

Protection Options
•

Fully protected (Line only)

•

Unprotected

•

PCA

•

DRI

Path protection is not supported.

Note

Split fiber with secondary
destinations

Manual/Auto

•

Fully protected

Line protection is not supported.

Note
•

DRI

7.8 Section and Path Trace
SDH J0 section and J1 and J2 path trace are repeated, fixed-length strings composed of 16 or 64
consecutive bytes. You can use the strings to monitor interruptions or changes to circuit traffic. For the
ONS 15310-MA SDH node, J0 section trace is supported for optical and E3 ports on the
15310E-CTX-K9, E1_21_E3_DS3_3, or E1_63_E3_DS3_3 cards. Table 7-9 shows the ONS 15310-MA
SDH cards and/or ports that support J1 and/or J2 path trace.
Table 7-9

ONS 15310-MA SDH Cards/Ports Capable of J1/J2 Path Trace

Trace Function

J1 or J2

Cards/Ports

Transmit and receive

J1

CE-MR-6
ML-100T-8

Receive

J1 and J2

CE-100T-8

J2

ONS 15310-MA SDH STMN, and E1 ports

J1

ONS 15310-MA SDH STMN, E1, and DS3
ports

If the string received at a circuit drop port does not match the string that the port expects to receive, an
alarm is raised. Two path trace modes are available:
•

Automatic—The receiving port assumes that the first string it receives is the baseline string.

•

Manual—The receiving port uses a string that you manually enter as the baseline string.
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7.9 Bridge and Roll
The CTC Bridge and Roll wizard reroutes live traffic without interrupting service. The bridge process
takes traffic from a designated “roll from” facility and establishes a cross-connect to the designated “roll
to” facility. When the bridged signal at the receiving end point is verified, the roll process creates a new
cross-connect to receive the new signal. When the roll completes, the original cross-connects are
released. You can use the bridge and roll feature for maintenance functions such as card or facility
replacement, or for load balancing. You can perform a bridge and roll on the following ONS platforms:
ONS 15600, ONS 15600 SDH, ONS 15454, ONS 15454 SDH, and ONS 15310-MA SDH.

7.9.1 Rolls Window
The Rolls window lists information about a rolled circuit before the roll process is complete. You can
access the Rolls window by clicking the Circuits > Rolls tabs in either network or node view. Figure 7-6
shows the Rolls window.
Figure 7-6

Rolls Window

The Rolls window information includes:
•

Roll From Circuit—The circuit with connections that will no longer be used when the roll process
is complete.

•

Roll To Circuit—The circuit that will carry the traffic when the roll process is complete. The Roll
To Circuit is the same as the Roll From Circuit if a single circuit is involved in a roll.

•

Roll State—The roll status; see the “7.9.2 Roll Status” section on page 7-19 for information.

•

Roll Valid Signal—If the Roll Valid Signal status is true, a valid signal was found on the new port.
If the Roll Valid Signal status is false, a valid signal was not found. It is not possible to get a true
Roll Valid Signal status for a one-way destination roll.

•

Roll Mode—The mode indicates whether the roll is automatic or manual.
CTC implements a roll mode at the circuit level. TL1 implements a roll mode at the cross-connect
level. If a single roll is performed, CTC and TL1 behave the same. If a dual roll is performed, the
roll mode specified in CTC might be different than the roll mode retrieved in TL1. For example, if
you select Automatic, CTC coordinates the two rolls to minimize possible traffic hits by using the
Manual mode behind the scenes. When both rolls have a good signal, CTC signals the nodes to
complete the roll.
– Automatic—When a valid signal is received on the new path, CTC completes the roll on the

node automatically. One-way source rolls are always automatic.
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– Manual—You must complete a manual roll after a valid signal is received. One-way destination

rolls are always manual.
•

Roll Path—The fixed point of the roll object.

•

Roll From Path— The old path that is being rerouted.

•

Roll To Path—The new path where the Roll From Path is rerouted.

•

Complete—Completes a manual roll after a valid signal is received. You can complete a manual roll
if it is in a ROLL_PENDING status and you have not yet completed the roll or have not cancelled
its sibling roll.

•

Force Valid Signal—Forces a roll onto the Roll To Circuit destination without a valid signal. If you
choose Force Valid Signal, traffic on the circuit that is involved in the roll will be dropped when the
roll is completed.

•

Finish—Completes the circuit processing of both manual and automatic rolls and changes the circuit
status from ROLL_PENDING to DISCOVERED. After a roll, the Finish button also removes any
cross-connects that are no longer used from the Roll From Circuit field.

•

Cancel—Cancels the roll process. When the roll mode is Manual, cancel roll is only allowed before
you click the Complete button. When the roll mode is Auto, cancel roll is only allowed before a good
signal is detected by the node or before you click the Force Valid Signal button.

7.9.2 Roll Status
Table 7-10 lists the roll statuses. You can only reroute circuits that have a DISCOVERED status. (See
Table 7-1 on page 7-3 for a list of circuit statuses.) You cannot reroute circuits that are in the
ROLL_PENDING status.
Table 7-10

Roll Statuses

State

Description

ROLL_PENDING

The roll is awaiting completion or cancellation.

ROLL_COMPLETED

The roll is complete. Click the Finish button.

ROLL_CANCELLED

The roll has been canceled.

TL1_ROLL

A TL1 roll was initiated.
Note

INCOMPLETE

If a roll is created using TL1, a CTC user cannot complete or
cancel the roll. Also, if a roll is created using CTC, a TL1 user
cannot complete or cancel the roll. You must use the same
interface to complete or change a roll.

This state appears when the underlying circuit becomes incomplete. To
correct this state, you must fix the underlying circuit problem before the
roll state will change.
For example, a circuit traveling on Nodes A, B, and C can become
INCOMPLETE if Node B is rebooted. The cross connect information is
lost on Node B during a reboot. The Roll State on Nodes A and C will
change to INCOMPLETE.
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7.9.3 Single and Dual Rolls
Circuits have an additional layer of roll types: single and dual. A single roll on a circuit is a roll on one
of its cross-connects. Use a single roll to:
•

Change either the source or destination of a selected circuit (Figure 7-7 and Figure 7-8,
respectively).

•

Roll a segment of the circuit onto another chosen circuit (Figure 7-9 on page 7-20). This roll also
results in a new destination or a new source.

In Figure 7-7, you can select any available VC high-order path on Node 1 for a new source.

S1

Single Source Roll

Node 2

Node 1

S2

D

Original leg
New leg

83267

Figure 7-7

In Figure 7-8, you can select any available VC high-order path on Node 2 for a new destination.

S

Single Destination Roll

Node 1

Node 2

D1

Original leg
New leg

D2

83266

Figure 7-8

Figure 7-9 shows one circuit rolling onto another circuit at the destination. The new circuit has
cross-connects on Node 1, Node 3, and Node 4. CTC deletes the cross-connect on Node 2 after the roll.

S

Single Roll from One Circuit to Another Circuit (Destination Changes)

Node 1

Node 2

D

Node 3

Node 4

D2

Original leg
New leg

78703

Figure 7-9

Figure 7-10 shows one circuit rolling onto another circuit at the source.
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Single Roll from One Circuit to Another Circuit (Source Changes)

S

Node 1

Node 2

S2

Node 3

Node 4

D

134274

Figure 7-10

Original leg
New leg

Note

Create a Roll To Circuit before rolling a circuit with the source on Node 3 and the destination on Node 4.
A dual roll involves two cross-connects. It allows you to reroute intermediate segments of a circuit, but
keep the original source and destination. If the new segments require new cross-connects, use the Bridge
and Roll wizard or create a new circuit and then perform a roll.

Caution

Only single rolls can be performed using TL1. Dual rolls require the network-level view that only CTC
or CTM provide.
Dual rolls have several constraints:
•

You must complete or cancel both cross-connects rolled in a dual roll. You cannot complete one roll
and cancel the other roll.

•

When a Roll To circuit is involved in the dual roll, the first roll must roll onto the source of the
Roll To circuit and the second roll must roll onto the destination of the Roll To circuit.

Figure 7-11 illustrates a dual roll on the same circuit.
Figure 7-11

S

Dual Roll to Reroute a Link

Node 1

Node 2
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Original leg
New leg

D

Figure 7-12 illustrates a dual roll involving two circuits.
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S

Dual Roll to Reroute to a Different Node

Node 1

Node 2

Node 3

Node 4

Original leg
New leg

Note

D

83102

Figure 7-12

If a new segment is created on Nodes 3 and 4 using the Bridge and Roll wizard, the created circuit has
the same name as the original circuit with the suffix _ROLL**. The circuit source is on Node 3 and the
circuit destination is on Node 4.

7.9.4 Two-Circuit Bridge and Roll
When using the bridge and roll feature to reroute traffic using two circuits, the following constraints
apply:
•

DCC must be enabled on the circuits involved in a roll before roll creation.

•

A maximum of two rolls can exist between any two circuits.

•

If two rolls are involved between two circuits, both rolls must be on the original circuit. The second
circuit should not carry live traffic. The two rolls loop from the second circuit back to the original
circuit. The roll mode of the two rolls must be identical (either automatic or manual).

•

If a single roll exists on a circuit, you must roll the connection onto the source or the destination of
the second circuit and not an intermediate node in the circuit.

7.9.5 Protected Circuits
CTC allows you to roll the working or protect path regardless of which path is active. You can upgrade
an unprotected circuit to a fully protected circuit or downgrade a fully protected circuit to an unprotected
circuit with the exception of a Linear Multiplex Section Protection circuit. When using bridge and roll
on Linear Multiplex Section Protection circuits, you can roll the source or destination or both path
selectors in a dual roll. However, you cannot roll a single path selector.

7.10 Merged Circuits
A circuit merge combines a single selected circuit with one or more circuits. You can merge VC
low-order path tunnels, LAP circuits, orderwire and user data channel (UDC) overhead circuits,
CTC-created traffic circuits, and TL1-created traffic circuits. To merge circuits, you choose a master
circuit on the CTC Circuits tab. Then, you choose the circuits that you want to merge with the master
circuit on the Merge tab in the Edit Circuits window. The Merge tab shows only the circuits that are
available for merging with the master circuit:
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•

Circuit cross-connects must create a single, contiguous path.

•

Circuits types must be a compatible. For example, you can combine a VC high-order path circuit
with a LAP circuit to create a longer LAP circuit, but you cannot combine a VC low-order path
circuit with a VC high-order path circuit.

•

Circuit directions must be compatible. You can merge a one-way and a two-way circuit, but not two
one-way circuits in opposing directions.

•

Circuit sizes must be identical.

•

Circuit endpoints must send or receive the same framing format.

•

The merged circuits must become a DISCOVERED circuit.

If all connections from the master circuit and all connections from the merged circuits align to form one
complete circuit, the merge is successful. If all connections from the master circuit and some, but not
all, connections from the other circuits align to form a single complete circuit, CTC notifies you and
gives you the chance to cancel the merge process. If you choose to continue, the aligned connections
merge successfully into the master circuit, and the unaligned connections remain in the original circuits.
All connections in the completed master circuit use the original master circuit name.
All connections from the master circuit and at least one connection from the other selected circuits must
be used in the resulting circuit for the merge to succeed. If a merge fails, the master circuit and all other
circuits remain unchanged. When the circuit merge completes successfully, the resulting circuit retains
the name of the master circuit.

7.11 Reconfigured Circuits
You can reconfigure multiple circuits, which is typically necessary when a large number of circuits are
in the PARTIAL status. When reconfiguring multiple circuits, the selected circuits can be any
combination of DISCOVERED, PARTIAL, DISCOVERED_TL1, or PARTIAL_TL1 circuits. You can
reconfigure tunnels, LAP circuits, CTC-created circuits, and TL1-created circuits. The Reconfigure
command maintains the names of the original cross-connects.
Use the CTC Tools > Circuits > Reconfigure Circuits command to reconfigure selected circuits. During
reconfiguration, CTC reassembles all connections of the selected circuits into circuits based on path size,
direction, and alignment. Some circuits might merge and others might split into multiple circuits. If the
resulting circuit is a valid circuit, it appears as a DISCOVERED circuit. Otherwise, the circuit appears
as a PARTIAL or PARTIAL_TL1 circuit.

Note

PARTIAL tunnel circuits do not split into multiple circuits during reconfiguration.

7.12 Server Trails
A server trail is a non-DCC (logical or virtual) link across a third-party network that connects two CTC
network domains. A server trail allows A-Z circuit provisioning when no DCC is available. You can
create server trails between two distant optical or STM-1E ports. The end ports on a server trail can be
different types (for example, an STM-4 port can be linked to an STM-1 port). Server trails are not
allowed on DCC-enabled ports.
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The server trail link is bidirectional and can be VC3, VC11, VC12, VC4, VC4-2c, VC4-3c, VC4-4c,
VC4-6c, VC4-8c, VC4-12c, VC4-16c, VC4-32c, and VC4-64c; you cannot change an existing server
trail to another size. It must be deleted and recreated. A circuit provisioned over a server trail must match
the type and size of the server trail it uses. For example, an VC4-3c server trail can carry only VC4-3c
circuits and not three VC4 circuits.

Note

There is no OSPF or any other management information exchange between NEs over a server trail.

7.12.1 Server Trail Protection Types
The server trail protection type determines the protection type for any circuits that traverse it. A server
trail link can be one of the following protection types:

Note

•

Preemptible—PCA circuits will use server trails with the Preemptible attribute.

•

Unprotected—In Unprotected Server Trail, CTC assumes that the circuits going out from that
specific port will not be protected by provider network and will look for a secondary path from
source to destination if you are creating a protected circuit.

•

Fully Protected—In Fully Protected Server Trail, CTC assumes that the circuits going out from that
specific port will be protected by provider network and will not look for a secondary path from
source to destination.

Only SNCP protection is available on server trails. MS-SPRing procection is not available on server trail.

7.12.2 VCAT Circuit Routing over Server Trails
An VC4-3c server trail can be used to route VC4-3c circuits and an VC4 server trail can be used to route
VC4 circuits. Similarly, a VC3 server trail can be used to route VC3 circuits.
For example, to route a VC4-3c-2v circuit over a server trail, you must enable split fiber routing and
create two VC4-3c server trails and route each member manually or automatically over each server trail.
To route a VC4-12c-2v circuit over a server trail, you must enable split fiber routing and create two VC4
server trails and route each member manually or automatically over each server trail.

Note

Server trails can only be created between any two optical ports or STM-1E ports.
VCAT circusits can be created over server trails in the following ways:
•

Manual routing

•

Automatic routing
– Diverse routing: This method enables VCAT circuit routing over diverse server trail links.

Note

When creating circuits or VCATs, you can choose a server trail link during manual circuit routing. CTC
may also route circuits over server trail links during automatic routing. VCAT common-fiber automatic
routing is not supported.
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For a detailed procedure on how to route a VCAT circuit over a server trail, refer “Chapter 6, Create
Circuits and VT Tunnels, Section NTP-A264, Create an Automatically Routed VCAT Circuit and
Section NTP-A265, Create a Manually Routed VCAT Circuit” in the Cisco ONS 15454 Procedure
Guide.

7.12.2.1 Shared Resource Link Group
The Shared Resource Link Group (SRLG) attribute can be assigned to a server trail link using a
commonly shared resource such as port, fiber or span. For example, if two server trail links are routed
over the same fiber, an SRLG attribute can be assigned to these links. SRLG is used by Cisco Transport
Manager (CTM) to specify link diversity. If you create multiple server trails from one port, you can
assign the same SRLG value to all the links to indicate that they originate from the same port.
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